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SmartDesign

SmartDesign has been re-designed to enable faster creation of simple to complex System on Chip (SoC) designs
including processor/bus based and Fusion mixed signal designs. Complete FPGA systems and subsystems can be
designed in minutes by selecting from Actel’s core libraries, making quick and error-free connections, and automatically

creating a synthesis ready HDL file.

Key Features

e Visual block-based design creation tool
° Replaces CoreConsole for processor, bus-based, and DirectCore subsystem creation

e Quickly select, configure, and connect proven functional blocks from Libero IDE Project Manager Catalog:

DirectCores, Smartgen Cores, and Actel cells

e Import and connect user generated IP, Designer Blocks, and custom/glue-logic HDL modules including

ViewDraw schematics
. SmartGuide guidance suggests compatible interfaces and notes required peripherals

e All construction is performed on a single Canvas

. All pins/ports are exposed and ready for connection on the Canvas

. Automatic or simple point-and-click manual connections

e Design-rule check disallows improper connections or unconnected ports
. Dynamic audit system informs of out-of-date configurations

e Automatic abstraction to synthesis-ready HDL: Verilog or VHDL
. Efficient construction of complex processor, bus based, Fusion mixed signal, and simple designs
e  Complete FPGA SoC, FPGA subsystem, or embedded SmartDesign-in-SmartDesign

SmartDesign supports all Actel product families.

SmartDesign Design Flow
SmartDesign enables you to stitch together design blocks of different types (HDL, IP, etc) and generate a top-level
design. The Files tab lists your SmartDesign files in alphabetical order.
You can build your design using SmartDesign with the following steps:
Step One — Instantiating components: In this step you will add one or more building blocks, HDL modules,

components, and schematic modules from the project manager to your design. The components can be Designer

blocks, SmartGen cores (cores generated from the core catalog), and IP cores.
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Step Two — Connecting bus interfaces: In this step, you can add connectivity via standard bus interfaces to your design.
This step is optional and can be skipped if you prefer manual connections. Components generated from the Catalog in

Project Manager may include pre-defined interfaces that allow for automatic connectivity and design rule checking

when used in a design.

Step Three — Connecting instances: The Canvas allows you to create manual connections between ports of the

instances in your design. Unused ports can be tied off to GND or VCC (disabled); input buses can be tied to a

constant, and you can leave an output open by marking it as unused.

Step Four — Validating the SmartDesign component: Verify the connectivity of your design using the Connectivity
Check feature. This feature opens a special grid where design errors and warnings are organized by type and message.
You can fix the errors and warnings directly in the grid. You must run the Connectivity Check again after you make

your connections to check for new errors and warnings.

Step Five — Generating the SmartDesign component: In this step, you generate a top-level (Top) component and its
corresponding HDL file. This component can be used by downstream processes, such as synthesis and simulation, or

you can add your SmartDesign HDL into another SmartDesign.

You can save your SmartDesign at any time.

Using Existing Projects with SmartDesign

You can use existing Libero® Integrated Design Environment (IDE) projects with available building blocks in the
project to assemble a new SmartDesign design component. You do not have to migrate existing top-level designs to

SmartDesign and there is no automatic conversion of the existing design blocks to the SmartDesign format.

Note: SmartGen cores used in previous versions of software will work in SmartDesign, but they will NOT include
standard bus interfaces if they are available. Bus interfaces (BIFs) can be recovered by regenerating the core in
the latest software.

Examples of cores with standard BIFs: ASB, Flash Memory System Builder, VRPSM, AMBA DirectCore(s),

and similar.

SmartDesign Frequently Asked Questions

The collection of SmartDesign Frequently Asked Questions are useful for anyone that is new to SmartDesign. All the
information listed below is explained in detail in other sections of the help, but the information is summarized here for

easy reference. Click any question to go to the corresponding explanation.

General Questions

1.  What is SmartDesign?

2. Howdo I create my first SmartDesign?

SmartDesign v8.4 User’s Guide
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Instantiating your SmartDesign

1.
2.
3.

Where is the list of cores that I can instantiate into my SmartDesign?

How do I instantiate cores into my SmartDesign?

I have a block that I wrote in VHDL (or Verilog); can I use that in my SmartDesign?

Working in SmartDesign

1.
2.
3.

ook

© N o

10.
11.
12.

How do I make connections?

Auto Connect didn’t connect everything for me; how do I make manual connections?

How do I connect a pin to the top level?

Oops, I just made a connection mistake. How do I disconnect two pins?

1 need to apply some simple ‘glue’ logic between my cores. How do I do that?

My logic is a bit more complex than inversion and tie offs - what else can I do?

How do I create a new top level port for my design?
How do I rename one of my instances?
How do I rename my top level port?

How do I rename my group pins?

I need to reconfigure one of my Cores; can I just double click the instance?

I want more Canvas space to work with!

Working with Processor-Based Designs in SmartDesign

1.
2.
3.
4,

How do I connect my peripherals to the bus?

How do I view the Memory Map of my design?

How do I simulate my processor design?

I have my own HDL block that I want to connect as a peripheral on the AMBA bus. How can I do that?

Making your Design Look Nice

DA

Can the tool automatically place my instances on the Canvas to make it look nice?
My design has a lot of connections, and the nets are making my design hard to read. What do I do?

My instance has too many pins on it, how can I minimize that?

Oops, I missed one pin that needs to be part of that group? How do I add a pin after I already have the group?

I have a pin that I don’t want inside the group, how do I remove it?

How can I better see my design on the Canvas?

SmartDesign v8.4 User’s Guide 9
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Generating your Design
1. Ok, I'm done connecting my design, how do I ‘finish’ it so that I can proceed to synthesis?

2. I get a message saying it’s unable to generate my SmartDesign due to errors, what do I do? What’s the

Connectivity Checker?

3. Is there an easy way for me to tie off multiple pins at once?

General Questions
What is SmartDesign?

SmartDesign is a design entry tool. It’s the first tool in the industry that can be used for designing System on a Chip
designs, custom FPGA designs or a mixture of both types in the same design. A SmartDesign can be the entire FPGA
design, part of a larger SmartDesign, or a user created IP that can be stored and reused multiple times. It’s a simple,
intuitive tool with powerful features that enables you to work at the abstraction level at which you are most
comfortable.

It can connect blocks together from a variety of sources, verify your design for errors, manage your memory map, and

generate all the necessary files to allow you to simulate, synthesize, and compile your design.
How do I create my first SmartDesign?
From the Project Manager Project Flow window, in the Design Entry Tools section, click the SmartDesign icon:
=

SmartDesign

Instantiating Your SmartDesign

Where is the list of Cores that I can instantiate into my SmartDesign?

The list of available cores is displayed in the Project Manager Catalog. This catalog contains all DirectCore IP,

SmartGen cores, and Actel macros (cells).
How do I instantiate cores into my SmartDesign?

Drag and drop the core from the Catalog onto your SmartDesign Canvas. The configurator for that core opens

automatically. Choose your configurations, click OK, and an instance of your core appears on the SmartDesign Canvas.
I have a block that I wrote in VHDL (or Verilog); can I use that in my SmartDesign?

Yes! Import your HDL file into the Project Manager (File > Import Files). After you do this, your HDL module will
appear in the Project Manager Hierarchy. Then, drag-and-drop it from the Hierarchy onto your SmartDesign Canvas.

Working in SmartDesign

How do I make connections?
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Working in SmartDesign

Let SmartDesign do it for you. Right-click the Canvas and choose Auto Connect.

Auto Connect didn’t connect everything for me, how do I make manual connections?
1. Select the pins you want connected by using the mouse and the CTRL key.
2. Right-click one of the selected pins and choose Connect.

3. For bus interface pins you can do the same thing, OR: Right click a bus interface pin, choose Find Compatible
Bus Interfaces. A dialog box will display a list of the compatible bus interfaces in the design that you can connect

to. Choose the bus interface you want to connect to from the list and click OK.
How do I connect a pin to the top level?

Right-click the pin and choose Promote to Top Level. You can even do this for multiple pins at a time, just select all
the pins you want to promote, right-click one of the pins and choose Promote to Top Level. All your selected pins will

be promoted to the top level.
Oops, I just made a connection mistake. How do I disconnect two pins?
Use CTRL+Z to undo your last action. If you want to undo your ‘undo’, hit redo (CTRL+Y).
To disconnect pins you can:
. Right-click the pin you want to disconnect and choose Disconnect
e Select the net and hit the delete key
I need to apply some simple ‘glue’ logic between my cores. How do I do that?

For basic inversion of pins, you can right-click a pin and choose Invert. An inverter will be placed at this pin when the
design is generated. You can also right-click a pin and choose Tie Low or Tie High if you want to connect the pin to

either GND or VCC.

To tie an input bus to a constant, right-click the bus and choose Tie to Constant. To mark an output pin as unused,

right-click the pin and choose Mark as Unused.
To clear these, just right-click on the pin again and choose Clear Attribute.

My logic is a bit more complex than inversion and tie offs - what else can I do?

You have full access to the Actel library cells, including AND, OR, and XOR logic functions. These are located in the
Project Manager Catalog, listed under Actel Cells. Drag the logic function you want onto your SmartDesign Canvas.

How do I create a new top level port for my design?

Scroll your design all the way to the left. Right-click the block on the far left of your Canvas (this represents the top
level of your design) and choose Add Port.

How do I rename one of my instances?

Double-click the instance name on the Canvas and it will become editable. The instance name is located directly above

the instance on the Canvas.
How do I rename my top level port?

Right-click the port you want to rename and choose Modify Port.

SmartDesign v8.4 User’s Guide 11
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How do I rename my group pins?

Double-click the group pin name in the instance and it will become editable.
I need to reconfigure one of my Cores, can I just double click the instance?

Yes.
I want more Canvas space to work with!

Maximize your workspace (CTRL-W), and your Canvas will maximize within the Project Manager. Hit CTRL-W

again if you need to see your Hierarchy or Catalog.

Working with Processor-Based Designs in SmartDesign

How do I connect my peripherals to the bus?

Make sure you have the proper bus core that is compatible with your peripheral instantiated in the design. Click Auto

Connect and SmartDesign will automatically form the connections.

But I need my peripheral at a specific address or slot.

Right-click the Canvas and choose Modify Memory Map to invoke the Modify Memory Map dialog that enables you

to set a peripheral to a specific address on the bus.

The bus core will show the slot numbers on the bus interface pins. These slot numbers correspond to a memory address

on the bus.
Verify that your peripheral is mapped to the right bus address by viewing your design’s Memory Map.
How do I view the Memory Map of my design?

In the Project Manager menu bar, choose SmartDesign > Show Memory Map/Data Sheet. This creates a datasheet of

your design, including the pin out, cores used, and memory map.

The memory map section will also show the memory details of each peripheral, including any memory mapped

registers.
How do I simulate my processor design?

SmartDesign automatically generates the necessary Bus Functional Model (BFM) scripts required to simulate your

processor based design. A top level testbench for your SmartDesign is generated automatically as well.
Create your processor design, generate it, and you will be able to simulate it in ModelSin.
I have my own HDL block that I want to connect as a peripheral on the AMBA bus. How can I do that?
If your block has all the necessary signals to interface with the AMBA bus protocol ( ex: address, data, control signals)

then:
1. In the Project Manager Catalog (inside the Bus Definitions tab), find the AHB or APB slave interface.

2. Drag this bus definition onto your instance on the Canvas. A dialog box opens, asking you to map the signals on

your instance to the required bus definition signals. Complete this mapping and click OK.
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Now your instance has a proper AMBA bus interface on it. You can manually connect it to the bus or let Auto

Connect find a compatible connection.

Making Your Design Look Nice

Can the tool automatically place my instances on the Canvas to make it look nice?
Yes. Right-click the Canvas white space and choose Auto Arrange Instances.
My design has a lot of connections, and the nets are making my design hard to read. What do I do?

You can disable the display of the nets in the menu bar (Canvas > Nets). This automatically hides all the nets in your

design.
You can still see how pins are connected by selecting a connected pin, the net will automatically be visible again.

You can also selectively show certain nets, so that they are always displayed, just right click on a connected pin and

choose Show Net.
My instance has too many pins on it; how can I minimize that?

Try grouping functional or unused pins together. For example, on the Corelnterrupt there are 8 FIQSource* and 32

IRQSource” pins, group these together since they are similar in functionality.
To group pins: Select all the pins you want to group, then right-click one of the pins and choose Add pins to group.
If a pin is in a group, you are still able to use it and form connections with it. Expand the group to gain access to the
pin.

Oops, I missed one pin that needs to be part of that group? How do I add a pin after I already have the group?
Select the pin you want to add and the group pin, right-click and choose Add pins to <name> group.

I have a pin that I don’t want inside the group, how do I remove it?
Right-click the pin and choose Ungroup selected pins.

How can I better see my design on the Canvas?

There are zoom icons in the toolbar: && % Ea £

From left to right, they are: Zoom in, Zoom out, Zoom to fit, and Zoom range. You can also maximize your

workspace with CTRL-W.

Generating Your Design

Ok, I'm done connecting my design, how do I ‘finish’ it so that I can proceed to synthesis?

In the Project Manager toolbar, click the Generate Design icon &) or right-click the Canvas and choose Generate

Design.

I get a message saying it’s unable to generate my SmartDesign due to errors, what do I do? What’s the Connectivity
Checker?

SmartDesign v8.4 User’s Guide 13
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The connectivity checker will give you a list of all the errors and warnings in your design, including unconnected input

In the Project Manager toolbar, click the Connectivity Checker icon:

pins, required pin connections, configuration incompatibilities between cores, etc.
Errors are shown with a small red octagon and must be corrected before you can generate, warnings may be ignored.
What does this error mean? How do I fix it?

Review the Connectivity Checker topic for an explanation of errors in the Connectivity Checker and steps to resolve

them.
Is there an easy way for me to tie off multiple pins at once?

Yes, if you are in the Connectivity Checker grid, you can select multiple pins by highlighting the rows that they are in.

Multi-selecting works just like your typical spreadsheet editor.

Once all the pins have been selected, right-click one of the pin names and choose Tie Low or Tie High. Make sure you

only have input pins selected otherwise the menu item won’t be enabled.
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Getting Started with SmartDesign

Creating a New SmartDesign Component

1. From the File menu, choose New or press the SmartDesign button in the Project Manager Project Flow

window. The New dialog box opens (see figure below - file types vary depending on your project settings).

Smaresig

Schematic

amartDesign Component M arme:
CoreConsole Component
IP Component |
YHDL Source File

Yerilog Source File

Skimulus

Stimulus HOL File

SO File {sdc)

Pheysical Design Constraink File (pdc)

WO File (wed)

SAIF File (saif)

YHOL Template

Yerilog Template

Help 0k, | Cancel

Figure 1 - New Dialog Box

2. Select SmartDesign Component, enter a component name and click OK. The component appears in the

Hierarchy tab of the Design Explorer. Also, the main window displays the design Canvas.

Note: The component name must be unique in your project.

Opening an Existing SmartDesign Component

To open an existing component do one of the following:
e In the Design Explorer, click the Hierarchy tab and double-click the component you want to open.

° In the Design Explorer, from the Files tab, expand the Components list and double-click the component you

want to open.

The main window displays the SmartDesign Canvas for the SmartDesign component.
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Saving/Closing a SmartDesign Component

To save the current SmartDesign design component, from the File menu, choose Save <component_name>. Saving a
SmartDesign component only saves the current state of the design; to generate the HDL for the design refer to

Generating a SmartDesign component.

To close the current SmartDesign component without saving, from the File menu, choose Close. Select NO when

prompted to save.

You can also close a SmartDesign component by right-clicking the name of the SmartDesign tab in the work area

window and choosing Close, as in the figure below.

—
EE Canvas  pectore
— Close

Figure 2 - Close a SmartDesign

Importing a SmartDesign Component

Deleting
Project

Memory

Importing an existing SmartDesign component into a SmartDesign project will not automatically import the sub-
components of that imported SmartDesign component.
You must import each sub-component separately.

After importing the sub-components, you must open the SmartDesign component and replace each sub-component so

that it references the correct component in your project. .

a SmartDesign Component from the Libero IDE

To delete a SmartDesign component from the project:
1. In the Design Explorer, click the Hierarchy tab.
2. Select the SmartDesign component that you want to delete. Right-click the component name and select Delete

from Project or Delete from Disk and Project, or click the Delete key to delete from project.

Maps / Data Sheet

If your design contains standard Bus Instances such as the DirectCore AIMBA bus cores, CoreAPB or CoreAHB, then
you can view the Memory Map Configuration of your design. To do so, from the SmartDesign menu, choose Show
Memory Map / Data Sheet.

The design’s memory map is determined by the connections made to the bus component. A bus component is divided
into multiple slots for slave peripherals or instances to plug into. Each slot represents a different address location and

range to the Master of the bus component.

16
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Memory Maps / Data Sheet

The datasheet reports the memory map of the different subsystems of your design, where a subsystem is any

independent bus structure with a Master and Slave peripheral attached.
Connecting peripherals to busses can be accomplished using the normal SmartDesign connectivity options:
. Auto-Connect - the system finds compatible bus interfaces and connects them together

e The Modify Memory Map dialog box

. Canvas - Make connections between your blocks.

¢  Finding compatible bus interfaces

Your application and design requirements dictate which address location (or slots) is most suitable for your bus
peripherals. For example, the memory controller should be connected to Slot0 of the CoreAHB bus because on Reset,
the processor will begin code execution from the bottom of the memory map.

The Memory Map View opens your default web browser to display the memory map information. An example is

shown in the figure below.

Data Sheet: SDTOP

Project Settings

FAM: Fusion

Die: AFSE00

Package: 256 FBGA

HDL: Werilog

Location: C./Documents and Settingsfareyc/Desktopfarieyc_Actelpri_84My First SmartDesign/componentiwork/SOTOP
State: NOTREADY

Table of Contents

O's
Cores
Memary Map
10's
Port Name Direction Pin li0 Standard
VAREF INOUT - LWTTL
cl_V IN - LWTTL
cl IN - LVTTL
il IN - LWTTL

al o g | _>lj

Figure 3 - Example Memory Map
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Modify Memory Map Dialog Box

The Modify Memory Map dialog box (shown in the figure below) enables you to connect peripherals to buses via a
drop-down menu. To open the dialog box, right-click on the Canvas or specific bus instance and choose Modify

Memory Map.

This dialog simplifies connecting peripherals to specific base addresses on the bus. The dialog shows all the busses in
the design; select a bus in the left pane to assign or view the peripherals on a bus. Busses that are bridged to other

busses are shown beneath the bus in the hierarchy.

Modify Memory Map |

Select Bus ko Wiew or Assign Peripheral(s) Assign peripherals to addresses on bus:

----- CoreAHE_0 Address Feripheral
0=00000000 CorefhbMvm_0AHE slave

010000000
Ox20000000
[0x30000000
[0x40000000
0x50000000
0xE0000000
0= 70000000
0=20000000
030000000
OxA40000000
OxE0000000
0=C0000000
0=D 0000000
0=E 0000000
OxFO000000

Help | (a4 Cancel

Figure 4 - Modify Memory Map Dialog Box

Click the Peripheral drop-down menu to select the peripheral you wish to assign to each address. To remove (unassign)

a peripheral from an address, click the drop-down and select the empty element.

Click OK to create the connections between the busses and peripherals in the design.

Finding Files in SmartDesign

Use the Find Window to search for ports, nets, or instances in SmartDesign.

Searching for ports / nets / instances in SmartDesign highlights the objects on the Canvas.
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SmartDesign User Interface

SmartDesign User Interface Overview
The SmartDesign tool is integrated into the Libero IDE Project Manager.

The Canvas is the main work area for SmartDesign. The Canvas view displays a high-level block diagram of your

design.

The Grid and Schematic views are available from the SmartDesign menu in the Project Manager. These views are not

required to complete your design.

The Grid displays your design in a configurable spreadsheet, enabling you to specify detailed connections for each

instance in your SmartDesign.
The Schematic View displays your design elements with port names, busses, and nets.

Changes made in one view will immediately be reflected in all other views, enabling you to quickly make and see

changes to your design.

You can close each view by right-clicking the name of the view inside the SmartDesign tab and choosing Close.

[<

)‘:'-_J'II Carivas E Schemnatic | ke ity Grid2|

Restore

Froject Flow I my_block, m

Figure 5 - Close the Active View

To re-open any view, from SmartDesign menu choose Show Canvas View, Show Grid View, or Show Schematic

View.
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Canvas View

Canvas Overview

The SmartDesign Canvas is like a whiteboard where functional blocks from various sources can be assembled and

connected; interconnections between the blocks represent nets and busses in your design.

You can use the Canvas to manage connections, set attributes, add or remove components, etc. The Canvas displays all

the pins for each instance (as shown in the figure below).

The Canvas enables you to drag a component from the Hierarchy, Files list, or a core from the Catalog and add an
instance of that component or core in the design. Some blocks (such as Basic Blocks) must be configured and generated
before they are added to your Canvas. When you add/generate a new component it is automatically added to your

Hierarchy.

To connect two pins on the Canvas, select any two pins on the Canvas (Ctrl + click to select a pin), right-click one of

the pins you selected and choose Connect. The Connect is disabled if you attempt to illegally connect two pins.

Click the Maximize Work Area button '-P to hide the other windows and show more of the Canvas. Click the

button again to return the work area to the original size.

The Canvas displays bus pins with a + sign (click to expand the list) or - (click to hide list). If you add a slice on a bus

the Canvas adds a + to the bus pin.

Components can be reconfigured any time by double-clicking the instance on the Canvas. You can also add bus
interfaces to instances using this view. In the Canvas view, you can add graphic objects and text to your design.

Inputs and bi-directional pins are shown on the left of components, and output pins are shown on the right.
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accl_0
subtr_1_0
Cin Cout
Enable Sum[1:0]
t Al Cin Cout
CrataB[1:0] Clock CrataAf1:0] Sum[1:0]
Crataa[1:0] Z CrataA1:0] CrataB[1:0]
Focd s 1
ATS_0
CF&BIG... CMORE
DBGEN
ASE_1 ™
SWS_CLK  DATAWA.. APS
2vS_RE... wl_f1
WAREF wl_f2
ol W ol _W ASSC_M..
ol ol ASSC_C...
Al Al ASSC_C...
ACMCLK RTCRA. .
ADC_CH...
As8
Figure 6 - SmartDesign Canvas
See Also

Canvas icons

22

SmartDesign v8.4 User’s Guide



PActel

Displaying Connections on the Canvas

The Canvas shows the instances, pins, and nets in your design (as shown in the figure below).

CrataB[1:0]
St e—

Displaying Connections on the Canvas

acct_0
subtr_1_0
Cin Cout
Enable Sum[1:0]
FAuclr Cin Cout
Clock CrataAf1:0] Sum[1:0]
DataA[1:0] CrataB[1:0]
ELLE suhbie

ASE_1

SYS_CLK

WAREF
ol W

=
&l
il

Scalar net connections are shown in blue; bus net connections are dark blue.

ACMCLK

SWS_RE...

DATAVA...
wl_f1

ATS_O

CF&EBIG... CMORE
DBGEN

IF

ATE

As8

Figure 7 - Components in SmartDesign
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Pin and Attribute Icons

Unconnected pins that do not require a connection are gray. &

Unconnected pins that require a connection are red.

Unconnected pins that have a default tie-off are pale green.

Connected pins are green. &

Right-click a pin to assign an attribute.

Pins assigned attributes are shown with an icon, as shown in the table below.

Table 1 - Pin Attribute Icons

Attribute Icon

Tie Low

Tie High

Invert

Mark as Unused

See the Canvas Icons reference page for definitions for each element on the Canvas.

Each connection made using a bus interface is shown in a separate connection known as a 'bus-interface net' (shown in

brown lines).

Move the mouse over a bus interface to display its details (as shown below).

1 ™y
mMarne: InitClient_InitCfgSave_hif
Fole: master
State: Connected

=

Formal Actual

INITADDE INIT_aDDR[&:0] i
INITDATA INIT_DATA[S:0] 4
INITOOMNE IMNIT_DOME

INITDATYAL=D |InitClient DAT_Wal
CLIENTDIM=O InitClient_DIN[E:0]
CLIEMTAWAILxO |InitClient_ AW &IL

D L

Hover over a bus interface net to see details (as shown below).
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Making Connections Using the Canvas

Bus-Interface Met: CoreAHBLite_0_AHBmslaveD
AHBMslavel
CoreAhbNym_D AHBslave

Making Connections Using the Canvas

Use the Canvas to make connections between instances.

To connect two pins on the Canvas, select any two (Ctrl + click to select a pin), right-click one of the pins you selected

and choose Connect. Illegal connections are disabled; the Connect menu option is unavailable.

Promoting Ports to Top Level
To automatically promote a port to top level, select the port, right-click, and choose Promote To Top Level. This
automatically creates top-level ports of that name and connects the selected ports to them. If a port name already exists,
a choice is given to either connect to the existing ports or to create a new port with a name <port name>_<i> where i =

1...n.
Double-click a top-level port to rename it.

Bus slices cannot be automatically promoted to top level. You must create a top level port of the bus slice width and

then manually connect the bus slice to the newly created top level port.

Tying Off Input Pins
To tie off ports, select the port, right-click and choose Tie High or Tie Low.

Tying to Constant
To tie off bus ports to a constant value, select the port, right-click and choose Tie to a Constant. A dialog appears (as

shown in the figure below) and enables you to specify a hex value for the bus.

To remove the constant, right-click the pin and choose Clear Attribute or Disconnect.

Tie To Constant E |

Marne: Datad[1:0]

Enter a hex walue; 0x m

(00 ko 030

Help | (04 I Cancel

Figure 8 - Tie to Constant Dialog Box
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Making Driver and Bus Interface Pins Unused

Driver or bus interface pins can be marked unused (floating/dangling) if you do not intend to use them as a driver in

the design. If you mark a pin as unused the Connectivity Checker does not return Floating Driver or Unconnected Bus

Interface messages on the pin.

Once a pin is explicitly marked as unused it cannot be used to drive any inputs. The unused attribute must be explicitly
removed from the pin in order to connect it later. To mark a driver or bus interface pin as unused, right-click the driver

or bus interface pin and choose Mark as Unused.

Simplifying the Display of Pins on an Instance using Pin Groups

The Canvas enables you to group and ungroup pins on a single instance to simplify the display. This feature is useful
when you have many pins in an instance, or if you want to group pins at the top level. Pin groups are cosmetic and

affect only the Canvas view; other SmartDesign views and the underlying design are not affected by the pin groups.

Grouping pins enables you to:

e  Hide pins that you have already connected

. Hide pins that you intend to work on later
. Group pins with similar functionality

e Group unused pins

. Promote several pins to Top Level at once

To group pins:
1. Ctrl + click to select the pins you wish to group. If you try to click-and-drag inside the instance you will move the

instance on the canvas instead of selecting pins.

Right-click and choose Add pins to group to create a group. Click + to expand a group. The icon associated with
the group indicates if the pins are connected, partially connected, or unconnected (as shown in the figure below).

bl

SS_CLK
WAREF wl_f2
ol W RTChiA...
1 ADC_CH...
+ 'Froup_2 ErOUpE

Group_ 1+

B4 L4

Figure 9 - Groups in an Instance on the Canvas
To add a pin to a group, Ctrl + click to select both the pin and the group, right-click and choose Add pin to group.
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‘ Bus Instances

To ungroup pins:

1. Click + to expand the group.

2. Right-click the pin you wish to remove from the group and choose Ungroup selected pins. Ctrl + click to select

and remove more than one pll’l ina group.

A group remains in your instance after you remove all the pins. It has no effect on the instance; you can leave it if you

wish to add pins to the group later, or you can right-click the group and choose Delete to remove it from your instance.

If you delete a group from your instance any pins still in the group are unaffected.

To promote a group to Top level:

1. Create a group of pins.

2. Right-click the group and choose Promote to Top level.

Bus Instances
Bus Components in the Actel Core Catalog, such as CoreAHB or CoreAPB, implement an on-chip bus fabric. When

these components are instantiated into your canvas they are displayed as horizontal or vertical lines. Double-click the

bus interfaces of your component to edit the connections.

Remap

HCLK
HRESETN
HEUSREGCHD
HGRAMNTMD
HLOCKMD

CoredHB
P Jdd S50

SYSCLK [y

Coreshbrym_0

CaredhbNym

Figure 10 - Bus Instance in SmartDesign

Positioning Busses on the Canvas
You may want to adjust the positioning and orientation of a bus on your canvas in order to organize the display of your

design.
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Rotating Busses
Bus instances can be rotated ninety degrees (they must be horizontal or vertical). To rotate a bus instance ninety

degrees left or right, right-click the black bar and choose Shape > Rotate Left (or Rotate Right).

Flipping Busses
You can flip a bus along the horizontal or vertical axis. To flip a bus, right-click the black bar and choose Shape > Flip
Horizontal (or Flip Vertical). Flipping a bus instance along an axis flips ALL the instances directly connected to the

bus instance, except those that are connected to another bus instance.

Adding Graphic Objects

You can document your design by adding comments and notations directly on the Canvas.

The Canvas toolbar (see figure below) enables you to add and modify decorative graphic objects, such as shapes, labels,

lines, and arrows on the Canvas.

NNOCAR@ Ga2aAsS Tale s s

Figure 11 - Canvas Toolbar

Adding and Deleting Lines and Shapes

To add a line or a shape:

—_

Select the line or shape button.

2. Click, drag and release on the Canvas. The table below provides a description of each button.

Description

Line

Rectangle

Button
N

] Arrow
o

O

Ellipse

Note: Hold the Shift key to constrain line and arrow to 45 degree increments or constrain the proportions of the

rectangle (square) or ellipse (circle).

To change the line and fill properties:

1. Select the element(s), right-click it, and choose Properties.

e Select Line to modify the color, style and width of the line.

. Select Fill to modify the crosshatch and the foreground and background colors.
2. Click OK.
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To delete a line or shape, select the object and press Delete.

Adding Text

To add text, select the text tool

box and then type.

To modify the text box properties:

1. Select the text box, right-click it, and choose Properties.

e Select Text to modify the text alignment.

. Select Line to modify the color, style and width of the line.

e Select Fill to modify the crosshatch and the foreground and background colors.

. Select Font to modify the font properties.

2. Click OK.

Adding Images

To add an image to the canvas:

1. Select the image button
2. Select the image you want to add and click OK.

3. Select the image and place it in the desired location.

Rotating Elements

o

. The Open dialog box opens.

Adding Graphic Objects

and click the Canvas to create a text box. To modify the text, double-click the text

Select the element(s) you want to rotate and click the appropriate rotate button. See the table below for a description of

each button.

Button

Description

G

Free rotate

Rotate to the left

Rotate to the right
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Flipping Elements

Select the element(s) you want to flip and click the appropriate flip button. See the table below for a description of each

button.
Button Description
Ak Flip vertically
= Flip horizontally

Aligning Elements

Select two or more elements on the Canvas and click the appropriate align button. See the table below for a description

of each button.

Button Description
[T} Align top

i Align middle

|]_|:|l Align bottom

= Align left

= Align center

5.' Align right

Grouping Graphic Objects

Objects on the Canvas can be grouped and ungrouped.
To group two or more elements, select the elements, right-click, and choose Grouping > Group.

To ungroup two or more elements, select the elements, right-click, and choose Grouping > Ungroup.

Ordering Elements (Z-order)

Elements on the Canvas can be positioned in front or in back of each other.

To change the order of the element(s), select the element and from the right-click menu, choose Order and select one

of the available options: Bring to Front, Send to Back, Bring Forward, or Send Backward.
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‘ Auto-Arranging Instances

Auto-Arranging Instances

m:
The Auto Arrange Instances button b arranges the instances on the Canvas. You can also right-click the Canvas

and choose Auto Arrange Instances from the right-click menu.

Locking Instance Position
You can lock the placement of any instance on the Canvas. Right-click an instance and choose Lock Location to lock

the placement. When you lock placement, the Auto Arrange Instances option has no effect on the instance.
To unlock an instance, right-click the instance and choose Unlock Location.

See Also

Bus instances

Auto-routing connections

Auto-Arrange Connections

The Auto Arrange Connections button ﬁ arranges the connections between instances. The way connections are
drawn is highly dependent on the placement of the instances on the Canvas. The top-level connections are shown

connected to the Top Level instance (green boxes).
Auto-arranging connections does not move instances; it places the nets between instances.
To auto-arrange your connections, right-click the canvas and choose Auto arrange connections.

Note: Select a placement for your instances that is reasonable with respect to connections before using Auto Route.

Replace Version for Instance

You can use the Replace Version for Instance dialog box (shown in the figure below) to restore or update version

instances on your canvas without creating a new instance and losing your connections.

Replace ¥Yersion for Instance
Instance: Coredhbhyvm_0
Component Yendor Library Yersion Change to Yersion
CorethbMwm Actel DirectCare 1.2

Figure 12 - Replace Version for Instance Dialog Box

To change the version of an instance:
1.  From the right-click menu choose Replace Component for this Instance. The Replace Version for Instance

dialog box appears.
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2. Choose a new version from the Change to Version drop-down menu. Click OK.

Slicing
Bus ports can be sliced or split using Slicing. Then the sliced ports can be connected as regular ports.

To create a slice:
1. Select a bus port, right-click, and choose Add Slice. This brings up the Add Slice dialog box (see figure below).

Add Slice

ADC_CHNUMBER [ 3 :|EI ]

Help | K, {I Cancel |

Figure 13 - Add Slice Dialog Box
2. Enter the parameters for the slice and click OK.

Note: Once a slice is created, other bus ports or slices of compatible size can be connected to it. Overlapping slices

cannot be created for IN and INOUT ports on instances or top-level OUT ports.

To remove a slice, select the slice, right-click, and choose Delete Slice.

Exposing Driver Pins
Pins that are contained as part of a bus interface will automatically be filtered out of the display. These ports are

considered to be connected and used as part of a bus interface.

However, there are situations where you may wish to use the ports that are part of the bus interface as an individual

port, in this situation you can choose to expose the pin from the bus interface.

The only ports that are allowed to be exposed are Driver Pins. Driver pins are outputs on instances or inputs on the

top-level. See Top-level connections for more information.

To expose a driver pin:
1. Select a bus interface port, right-click, and choose Expose Driver Pin. The Expose Driver Pin dialog box appears

(as shown below).

Driver Pins To Expose |

BIF: =TLOscClk_bif
Diriver Ping:

Figure 14 - Expose Driver Pin Dialog Box
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Instance Properties

2. Click the checkbox associated with the driver pin you want to expose. Once the port is exposed it appears in the

Grid and is available for individual connection.

To un-expose a driver pin, right-click the exposed port and choose Hide BIF Driver Pin.

Instance Properties

Right-click a component instance and choose Properties to view the Name, Instance Name, and port information -

name/direction-.

This dialog box is useful if you want to view the list of Port Names available in the instance from the Canvas view

instead of the Grid.

See Also

Grid overview

Display panel
Connection panel

Rename Net

To rename a net:

1. Right-click the net on the Canvas and choose Rename Net. This opens the Rename Net dialog box.
2. Type in a new name for the net.

Note: The system automatically assigns net names to nets if they are not explicitly specified. Once you have specified a

name for a net, that name will not be over-written by the system.

Automatic Names of Nets

Nets are automatically assigned names by the tool according to the following rules:

In order of priority
1.  If user named then name = user name
2. Ifnetis connected to top-level port then name = port name; if connected to multiple ports then pick first port

3. Ifthe net has no driver, then name = net_[i]
4. If the net has a driver, name = instanceName_driverpinName
Slices

For slices, name = instanceName_driverpinName_sliceRange; for example

u0_outl_4tob6.
GND and VCC Nets
The default name for GND/VCC nets is net. GND and net_ VCC.
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Expanded Nets for Bus Interface Connections

Expanded nets for bus interface connections are named busInterfaceNetName_<i>_driverPinName.

Organizing Your Design on the Canvas

You may find it easier to create and navigate your SmartDesign if you organize and label the instances and busses on

the Canvas.

You can show and hide nets, lock instances, rotate busses, group and ungroup pins, rename instances / groups / pins,

and auto-arrange instances.

To organize your design:

1.

Click the Auto-Arrange button to automatically arrange instances on the Canvas. SmartDesign's auto-arrange

feature optimizes instance location according to connections and instance size.

Right-click any instance and choose Lock Location to fix the placement. Auto-Arrange will not move any

instances that are locked.

Click Auto-Arrange again to further organize any unlocked instances. Continue arranging and locking your

instances until you are satisfied with the layout on the Canvas.

If your design becomes too cluttered:

1.

Hide the display of nets by de-selecting Canvas > Nets. This hides all the scalar and bus nets on your Canvas.
You can also right-click a pin and choose Show Net (or Hide Net) to show/hide individual nets. Note that

selecting a pin will make the corresponding net temporarily visible.

Group your pins. It may help to group pins that are functionally similar, or to group pins that are already

connected or will be unused in your design.

To further customize your design's appearance:

1.

Double-click the names of instances to add custom names. For example, it may be useful to rename an instance
based on a value you have set in the instance: the purpose of an instance named 'array_adder_bus_width_5"is

easier to remember than 'array_adder_0'.

Right-click any bus and choose Shape > Rotate Left or Right to change the bus orientation (horizontal or

vertical). Click and drag the bus to a new location and lock, if necessary.

34

SmartDesign v8.4 User’s Guide



Grid

Grid Overview

The Grid (see image below) provides a mechanism for making manual connections between building blocks in your
design. The grid displays your design in a spreadsheet for sorting and filtering, enabling you to quickly access and

manipulate any subset of your design.

The Grid shows block instances vertically and horizontally on the spreadsheet, such that the port rows on the

spreadsheet intersect with port columns. Each intersection of rows and ports on the spreadsheet provides a connection

opportunity.

The grid is divided into two panels, the Display panel and the Connection panel.

The Grid offers two different views: the Instance-Instance view and the Net-Instance view. The behavior of the two

panels is the same in both views.
The default display of the Grid shows connections between all the instances in your design in an Instance-Instance

view.

Actel recommends that you work with only a subset of the instances in the current design when making manual
connections. This greatly reduces the information displayed in the Grid view and makes it easier to create manual

connections.

Click the Maximize Work Area button $ to hide the other windows and show more of the Grid.

To create new Grids with just a subset of instances, select the instances between which you are making connections on
the Canvas, then right-click and choose Edit Connections. A new Grid will be displayed, with only those instances and

the top-level. When you are done making connections, right-click the grid view name tab and close the subset view.

To further simplify the data search in the grid and to make connections efficiently, use Filtering, Hierarchical sort in

the instance-instance view, and the find unconnected ports (Hide All Connected Ports) features.
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Display Panel Connection Panel
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Figure 15 - Grid (Instance-Instance View)

To switch to Net-Instance view, click the Net-Instance view radio button.

To reset to the default view, from the Grid menu, choose Reset Instance [Net] View to Default.

See Also

Grid - Display panel icons

Grid - Connection panel icons
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‘ Display Panel

Display Panel
You can use the fields in the Display panel to manage content. To add or remove a field, right-click the field title (such

as Instance in the image below) and from the right-click menu choose Fields. New fields appear to the right of the

fields already shown. To filter the list of nets or instances in the Display panel, use the Custom Filter.

#® |[nstance-Instance View
i Net-Instance View

Instance [»/= Port Hame = S5h_[+
= SDTOP ———{1> ADDRA [4:0]
> ADDRE [4:0]
HT> o1
HT> c1_W
T> CLKO _
HE> DINA [31:0]
> DINE [31:0]

L[> PUB
L[> RCOscClk_bif

] RTCMATCH
L[ S5YS_CLK
T 5S_RESET
HE w1

L@ v1_fl

L@ v1_f2

—H- VAREF

D XTL R
L[> XTLOscClk_bif

ASB_D
FMB_D

Figure 16 - Instance-Instance View Display Panel
The Display panel may list the following fields:

e Instance: Displays instances in the current design.

. Direction: Displays the port direction and bus interface type. Port directions are defined as IN, OUT and
INOUT, bus interfaces are shown as MASTER, SLAVE, and SYSTEM.

. Port Name: Lists port names for all instances. Also displays an icon that indicates if the port is connected
(green), disconnected (white), partially connected (green and white), input (I), output (O), master (yellow M),
INOUT (small horizontal arrows), a system bif, or slave (S).

. Slice: Displays bit order (i.e. [7:0]) of busses and slices. Slice is not available for scalars and bus interfaces.
e Width: Displays the size of the bus for any bus port. One for a scalar and zero for a bus interface port.

. Net: Identifies the net for each instance connection.
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Click the plus button #l to expand the information listed for the selected instance or direction. Click the minus button
=l to collapse the information displayed for the selected instance or direction. You can add and remove fields to meet

your needs.

Use the filter button E to filter the contents of each column. To sort the content of a column, click the Filter button
and select Sort Ascending or Sort Descending. Choose Custom Filter to open the Custom Filter dialog box. You can

use the Custom Filter dialog box to choose the nets, instances and slices you wish to display.

Right-click the column heading and choose Fit This Column To Data to expand (or shrink) the column to match the

column width to the size of the field name.

Promoting Ports to Top Level

To automatically promote a port to top level, select the port, right-click, and choose Promote To Top Level. This
automatically creates top-level ports of that name and connects the selected ports to them. If a port name already exists,
a choice is given to either connect to the existing ports or to create a new port with a name <port name>_<i> where i =

1...n.

Bus slices cannot be automatically promoted to top level. You must create a top level port of the bus slice width and

then manually connect the bus slice to the newly created top level port.

Tying Off Input Pins

Click in the Grid Attribute column and select Invert, Tie Low, or Tie High to tie the Port.

Making Driver and Bus Interface Pins Unused

Driver or bus interface pins can be marked unused (floating/dangling) if you do not intend to use them as a driver in
the design. If you mark a pin as unused the Connectivity Checker does not return Floating Driver or Unconnected Bus

Interface messages on the pin.

Once a pin is explicitly marked as unused it cannot be used to drive any inputs. The unused attribute must be explicitly

removed from the pin in order to connect it later. To mark a driver or bus interface pin as unused:
. Right-click the driver or bus interface pin and choose Mark as Unused

. In the Grid Attribute column, click the attribute and select Mark as Unused

Finding Unconnected and Partially Connected Ports

The grid allows you to quickly find all the unconnected ports in your design. To filter the grid to only show these ports,

from the SmartDesign menu, choose Grid > Hide All Connected Ports.
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Compatibility Rules

If the port selected on the row is a top-level port with a direction IN or an instance port with direction OUT, all

ports of direction IN and INOUT on the instances are compatible with it.

Connection Panel

If the port selected on the row is a top-level port with direction OUT or instance port with direction IN or

INOUT, all ports with direction IN are compatible with it.

Bus ports or slices are only compatible with bus ports or slices of equal size.

If there are no compatible connections between a port in the row area and an instance in the column area, the cell

is shaded and unavailable.

The pull-down menu in the cells only lists compatible ports.

See Also
Connection panel

Making connections

Filtering views

Grid - Display panel icons

Connection Panel

The Connection panel (the area to the right side of the grid) shows the Attribute column, the "top" (top-level), and the

Port Name to which the port is connected (if any).

] Instances =
Aftribute To
Plcount8_o]my block 0
FAD ACT
Pal &40
Pal A
FAD PUE
Al Sv'S_RESET
WRPL e
FaD ®TL L
Pal WAREF WAREF
EIF
EIF

Figure 17 - Instance-Instance Connection Panel
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Use the filter = button to filter and select which columns you wish to view, or to sort the contents of the columns in

ascending or descending order.

Attribute Column

The attribute column specifies additional properties of a port on the instance. These are:

PAD - Indicates that the port is a chip-level package pin. In SmartDesign, these ports are automatically promoted to

the top-level and are read only.

BIF - Indicates that the port is a Bus Interface.

GND . ¥ - Tie the port to logic 0.
VCC .- Tie the port to logic 1.

Invert .- Invert the polarity of this port. Inverting a port automatically instantiates an inverter into the generated HDL

file:
e For adriver: Inverter added after pin or port.
. For a non-driver: Inverter added before pin or port.

Unused - Indicates the pin has been assigned the float attribute and is not included in the Connectivity Check.

<design name> Column

The <design name> column represents the top-level; the name of the column depends on the name of your design.

Instances Column(s)

An instance column represents an instance that an instance-port of a row can be connected to.

See Also
Display panel
Making connections
Filtering views

Grid - Connection panel icons
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Instance-Instance View
The Instance-Instance view (see figure below) is divided into two panels: the Display panel and the Connection panel.

By default, the Display panel shows Instance, Port Name, and Slice information.

By default, the Connection panel begins at the Attribute column, and lists instances in the design and their ports. You
can show/hide any column in either panel; if you modify the view and wish to reset it, right-click the Instance-Instance

View radio button in the Display panel and choose Reset Instance View to Default.

Display Panel Connection Panel
I 1
#® Instance-Instance View Instances =

T Net-Instance View .

Adtribute SDTOP
Instance [/ = Port Mame = Sl [+ ASB_0 FMB_0 NGMUXBLK_0
= SDTOP 1> ADDRA [4:0] . . .
LT ADDRB [4:0]
HD> el PAD
HE> c1_¥ PiD

HI> DINA [31:0]
| @ DINB [31:0]
L& PUB FAD
Ht> RCOscClk_bif BIF . e
| @] RTCHMATCH RTCMATCH o=
HI» S¥S_CLK THIT_CLK
HI» S¥S_RESET SYS_RESET (S¥S_RESET
HE> w1 PAD vl
L] v1_f1 AH
L] v1_f2 Wi
& VAREF FaD YAREF YAREF
L@ KTL BAD
L XTLO=cClk_bif BIF

ASB_0
FMB_D
= NGMUXBLK_0 —{3> CLKO CLKD
HE= CLK1
48] GL

Hi» s o
= ram_reader_0 —r@ avgdata [11:0]

INIT_DOME

Figure 18 - Instance - Instance View
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Adding and Removing Fields

To add a field in the Display panel, right-click the field title (such as Direction in the image below) and from the right-
click menu choose Field, and select the field you wish to add or remove. Added fields appear at the end of the list of
fields.

You can add fields to view additional information about a port. Also, adding the field enables you to Sort your design
based on fields.

#® |[nstance-Instance vView
> Net-Instance Yiew

Instance [+ Nirectinn5Fl= Port [« Slice[¥
Eit This Calurmn

Shiows &l Rows

AL T

o i
» [ 5¥| v Instance

B VR .
B ®T—
INOUT # Al PortHame
ouT v W
= IN B Ac  widt
= Count8_0 [ Clock 70
= ouT 0)=a [7:0]

[7:4]

my_ccc_0
my_rc_osc_1| MASTER [M> RCOscClk_bif

Figure 19 - Add Field Menu in Display Panel

To add an instance in the Connection panel, click the drop-down arrow in Instances (as shown in the figure below),
and choose Custom Filter. The Custom Filter dialog box appears. Select checkbox for the instance you wish to view, or

use the Find box to search for a specific instance or range of instances.

Instances %L
» Sork Ascending

CCIU ntg_ﬂ m}’_blﬂ Ck_' Sork Qescending
AT
2410 Show All Instance Columns
A1 Custom Eilter. ..

Figure 20 - Add an Instance with Custom Filter in Connection Panel
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Sorting with Fields

Sorting with Fields

The field columns inside the Grid can be used to sort the ports in your design.

The hierarchical order is defined by the order of the columns (left to right). The data within each field is sorted

alphabetically. To change the hierarchical view, select a column and drag the column to the left or the right.

For example, this may be useful if you wish to see all of your INPUT ports together or if you want to see all of your 8-

bit busses together. The image below shows the Display Panel sorted by Port Name.

#® Instance-Instance View

T Net-Instance View

= Port Hame [=[= Width[»/| Met =
% A_RCOscClk_bif| 0 net G
[ AC1 1 net_3
)] AC1 _Overla 1 net_17
)] AC1_Underla 1 net_15
-‘ Aclr 1 net_8
@] ASSC_CHLATD | 1 net 9
)] ASSC_CHSAT 1 net_13
)] ASSC_DOMNE 1 net_20
@l] ASSC_WAIT 1 net_16
[ AvVD 1 net_2
@] AYD _Overlph 1 net_18
@] AVD_Dver?ph 1 "% net_19
@] AVD_Dver3p3 1 net_14
)] AVD OverSpD 1 net_11
[ AV 1 net_1
)] AY1 Over3p3 1 net_12
@] AY1 Under3p3 | 1 net_10
[I> Clock 1 net_24
)] FPGAGODOD 1

@] GLA 1 net_24
4] LOCK 1

Figure 21 - Display Panel Sorted by Port Name
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Making Connections Using the Grid

To make connections between ports on two instances:
1. Click in the intersection between the port (row) and the instance (column). SmartDesign displays a drop-down

list of compatible ports from the instance on the column area.

2. Select the desired port to make the connection. In the figure below, the port SYS_RESET from the instance
Top is being connected to port Aclr in the instance Count8_0. Note that the unconnected ports are shown in

white.

# |[nstance-Instance View Instances =

Y Net-Instance View Attribute | FusionDesign
Instance [ Port Name [¥]| Slicelx] ASB_DJDYNPLLELK_DJFMB_0

= NGMUXBLK_0 3> CLKD GLA
HE> CLK1
] GL SYS_CLK INIT_CLE
LT 5

= RAMINIT1_0 —[1> ADDRA [4:0]
[1: ADDRB [4:0]
I BLKA

H1> BLKB

HE> CLKA @] GLA
HE» CLKB BGLC
HT> DINA [31:0] g e

1> DINB [31:0]
] DOUTA [31:0]
@] DOUTE [31:0]
HT> INITACTIVE

] InitCfg_bif BIF e e T RAMIML..
HT> RESET
HT> RwhA

LT RwB
RAMINITZ 0 | |

= SYMCFIFO_0 — <] AEMPTY

L] AFULL

L[T> DATA [7-0
5] EMPTY

L4 FULL FULL

w Only Unconnected

Figure 22 - Making Connections Between Two Ports on Two Instances
To disconnect an existing connection, click in the intersection between the port and the instance and choose

Disconnect.

See Also

Connecting multiple ports (Connection panel)

Filtering views
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Connecting Multiple Pins (Connection Panel)

Connecting Multiple Pins (Connection Panel)
The Connect Multiple dialog box enables you to make multiple connections to a pin or net.

In the Instance to Instance view you can easily connect multiple non-driver pins from a single instance to a driver pin.

To do so:

1. Click a cell intersection of a driver pin and you will see a drop down with Connect Multiple. Choose Connect

Multiple to open the dialog box below.

Conneck Multiple Pins |

Fraom Instance: SDTOP
Pork: S%5_RESET

To instance: NGMLIXELE_O
Parts: [ [E CLKo

(1B cLk1
(1 s

Ik Zancel |
las

Figure 23 - Connect Multiple Pins Dialog Box - Instance to Instance

2. The dialog box lists all the compatible non-driver pins that can be connected to the selected driver pin. Click the

checkbox to connect these pins to the driver pin.
In the Net to Instance view you can easily connect multiple pins from a single instance to a net. To do so:

1. Click a cell intersection of an existing net and you will see a drop down with Connect Multiple. Choose
Connect Multiple to open the dialog box below. The dialog box lists all the compatible non-driver pins that can

be connected to this net.
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Connect Multiple Pins x|

From Instance: NGMUXELE_O

To nek: nek_WiZC
Ports: | [@ cLeo
LK1

[ s

[+ &llow Feedback Connection
:
Help | Ik I Cancel |

Figure 24 - Connect Multiple Pins Dialog Box - Net to Instance

2. Click the checkbox to connect these pins onto the net.

3. If the instance has driver pins available, you can click the checkbox for Allow Feedback Connection to select the

driver pin for this net.

See Also
Filtering views

Connection panel
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Net-Instance View

The Net-Instance view is a simplified version of the Instance-Instance view. Instead of an expandable list of every

PActel

Net-Instance View

instance in your SmartDesign, the Display panel lists only the net names that are connected to an instance. This view is

useful if you wish to see which nets are connected to an instance without changing your settings in the Instance-

Instance view. The Display and Connection panels in the Net-Instance view behave the same in both views.

The default Display panel in Net-Instance view lists the nets in your design; the default Connection panel lists all

instances (see figure below).

Z Instance-Instance View
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(8]
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[6]
[51
4
31
21
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(0]
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® Net-Instance VYiew epTOP
= Net ~  Shicel™ GNDJNGMUXBLE_0]ram_reader_0] RAM_SAVE_D
ASB O RTCMATCH

RTCMATCH

nitClgSave_bif
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Figure 25 - Net-Instance View, Display and Connection Panels

To switch to Net-Instance view, click the Net-Instance radio button. To reset to the default view, from the Grid

menu, choose Reset Net View to Default.

See Also

Connect to an existing net (Net-Instance view)

Connection panel
Display panel
Filtering views
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Connect to an Existing Net (Net-Instance View)

To connect to an existing net, select the ports to be connected from the drop-down list by clicking in the cell at the

intersection of the net and the instance (see figure below).

 Instance-Instance View Instances =
#® Net-Instance View To
Net = Shce P Count8_0fmy_block_0f my_ccc_0
net_2 AN AT
net_20 ASSC_DOME ASSC_DIOME -
net_21 QADMNRST Connect Multiple. ..
net_22 “Show Only Unconnected
net_23 [7-4] Q[7-4] Q[7-4] ] GLa
net_24 Clock, 55_Cl <] Lock
net_3 A1 A1 ' OADVRST %
net 5 PUE PLUE
net_G& A_RCOzcClk_bif
net_7 YRPU YRPU
net_& SYS_RESET Al SYS_RESET
net_ 9 ASSC_CHLATD ASSC_CHLATD

Figure 26 - Connecting to an Existing Net
Any net can have at most one driver. IN ports of the top-level or OUT ports from instances are considered drivers. If
another driver is for an already driven net, the current driver will be disconnected and the new driver will be connected

to the selected net.

See Also
Connection panel

Display panel
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Make New Connection (Net-Instance View)

To connect to a new net, select the ports to be connected from the drop-down list. Click the cell at the intersection of

the (unconnected) net row and the instance. This creates a new net (see figure below).
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Figure 27 - Making a New Connection
See Also

Connect to an existing net (Net-Instance view)

Connection panel

Display panel

Make New Connection (Net-Instance View)
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Filtering Views

To reduce the amount of data shown on the screen, you can display it selectively. The easiest way to hide an entry is to
right-click the cell and choose Hide Selection. To show the entry again, you can right-click at the top and choose
Show All Rows.

>

The Grid enables you to filter all instances within the design, as well as their direction, ports and slices. The example

For more control over the data display, use the Custom Filter available from the button == on the header row.

below filters by instance, but you can filter any column in the Display panel with the same procedure.

To filter the contents in the grid:

1. Use the filter E button and choose Custom Filter to bring up the filter box (see figure below).

Instance:

iy Find I
ak | Cancel

Figure 28 - Custom Filter Box in the Display Panel
2. From the filter box, you can find and select multiple values. In the image above, the Find field has highlighted all

the instances that start with 'my’, * is a wildcard. You must click inside the checkbox to select, or de-select,

highlighted values.
3. Click OK to commit your changes.

To hide data in the grid:

Select the rows you want to hide, right-click and choose Hide Selection.

To restore grid data:
From the SmartDesign menu, choose Connectivity View > Reset Instance View to Default.

See Also
Connection panel

Display panel
Making connections
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Schematic Overview

The Schematic view (see figure below) displays a detailed connection diagram for all instances, ports, and pins in the

current design with lines representing nets. This view is the closest representation to the exported HDL.

You can zoom the contents in the Schematic view or split the Schematic view into multiple pages.

new [
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E Schematic |f&g_'ll Eanvas] m Connectivity Grid 1 ]

Figure 29 - Schematic View
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Page Splitting
By default, the Schematic view displays large designs using multiple pages. Page splitting enables you to quickly
compute and display the schematic. You can turn off page splitting to view your entire design on a single page. For

larger designs, when this option is turned off, it may take SmartDesign longer to display the schematic.

To turn page splitting on or off, from the SmartDesign menu, choose Schematic View > Allow Page Splitting.

To navigate to the next page in a design, from the SmartDesign menu, choose Schematic View > Go to Next Page.
To navigate to the previous page, from the SmartDesign menu, choose Schematic View> Go to Previous Page.

To navigate to the first page, from the SmartDesign menu, choose Schematic View > Go to First Page.

To navigate to the last page, from the SmartDesign menu, choose Schematic View> Go to Last Page.

Zooming

The zoom tool in the Schematic View enables you to zoom fit the contents of your design within the window.
To zoom fit the design, click and drag to the bottom left corner of the window.

Zoom in and out of your schematic using the zoom icons on your toolbar.
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Creating a SmartDesign

Adding Components and Modules (Instantiating)

SmartDesign components, SmartGen cores, IP cores, and HDL modules are displayed in the Hierarchy, Files, and

Find output window.

To add a component, do either of the following:

e Select the component and drag it to the Canvas or Grid.

e Select a component, right-click, and choose Instantiate in SmartDesign <name>.

The component is instantiated in the design.

SmartDesign creates a default instance name. To rename the instance, double-click the instance name in the canvas.

Note: HDL modules with syntax errors cannot be instantiated in SmartDesign. However, since SmartDesign requires
only the port definitions, the logic causing syntax errors can be temporarily commented out to allow

instantiation of the component.

Adding a SmartDesign Component in a Higher-level Design
(Instantiating)

SmartDesign components can be instantiated into another SmartDesign component.

Once a SmartDesign is generated, the exported netlist can be instantiated into HDL like any other HDL module.

Adding Top Level Ports / Renaming External Pads in a
SmartDesign

You can add ports to, and/or rename ports in your SmartDesign.

To add ports:
1. From the SmartDesign menu, choose Logic > Add port. The Add Port dialog box appears (as shown below).
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Add New Port |
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Figure 30 - Add New Port Dialog Box
Specify the name of the port you wish to add. You can specify a bus port by indicating the bus width directly into

the name using brackets [ ], such as mybus[3:0].

3. Select the direction of the port.
To remove a port from the top level, select the port in the Grid, right-click and choose Delete Top Level Port.

To rename a top-level port, right-click the top-level non-pad port and choose Modify Top Level Port. You can rename

the port, change the bus width (if the port is a bus), and change the port direction.

To rename an external pad:
1. Right-click a pad in the top-level port and select Rename External Pad. The Rename External Pad dialog box

appears, as shown in the figure below.

Rename External Pad PUB x|

Mame: I m

[ireckion:
o Impuk
T Output
" Bi-directional {Inout)

Help | (4 I Cancell

Figure 31 - Rename External Pad Dialog Box

2. Enter the new name for the external pad and click OK.

See Also

Top level connections
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Connecting Instances

Automatic Connections

Using automatic connections (as shown in the figure below) enables the software to connect your design efficiently,

reducing time required for manual connections and the possibility of introducing errors.

To auto connect the bus interfaces in your design, right-click the design Canvas and select Auto Connect, click the

Auto Connect button Ra ; or from the SmartDesign menu, choose Auto Connect.

You can select individual pins or groups on the Canvas to auto-connect. Select the pins, right-click and choose Auto

Connect.
SmartDesign searches your design and connects all compatible bus interfaces.
SmartDesign will also form known connections for any SoC systems such as the processor CLK and RESET signals.

If there are multiple potential interfaces for a particular bus interface, Auto Connect will not attempt to make a

connection; you must connect manually. You can use the Canvas, Grid or the Find Compatible Bus Interface dialog

box to make the manual connection.

CORESO0Z1S_0 COREUART_O
CLK PRESETHM BAUD_ V... DATA O
MEYSRESET MEYSRE... WDOGRE.. BITS O%ERFL...
WDOGRES A CLK PARITY _...
IMTO External...x CEM RXRDY
IMT1 DATA M. T+
Dbl QDD _M_... THRDY
OEN
P
PARITY ...
RESET_M
CORESNS!S s
VWEM
Cored PE3 g
COREUART

CDreGPIO_DL

SYSCLK pp— PCLK datacu]...
PREZETR

dataln[3 ...

Core GRIO

Figure 32 - Auto-Connected IP Cores

Manual Connections

To make manual connections between to pins on the Canvas, select both pins (use CTRL + click), right-click either

pin and choose Connect. If the pins cannot be legally connected the connection will fail.
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Deleting Connections

To delete a net connection on the Canvas, click to select the net and press the Delete key, or right-click and choose

Delete.

To remove all connections from one or more instances on the Canvas, select the instances on the Canvas, right-click

and choose Clear all Connections. This disconnects all connections that can be disconnected legally.

You can also select one or more rows in the Grid and choose Remove Connections from Selected Ports from the right-

click menu to remove the connects for a group of Ports.
If you click in a cell displaying a connection, selecting Disconnect from the drop down removes just that connection.

Certain connections to ports with PAD properties cannot be disconnected. PAD ports must be connected to a design’s
top level port. PAD ports will eventually be assigned to a package pin. In SmartDesign, these ports are automatically

promoted to the top level and cannot be modified or disconnected.

Top-Level Connections

Connections between instances of your design normally require an OUTPUT (Driver Pin) on one instance to one or

more INPUT(s) on other instances. This is the basic connection rule that is applied when connecting.

However, directions of ports at the top level are specified from an external viewpoint of that module. For example, an
INPUT on the top level is actually sending (‘driving’) signals to instances of components in your design. An OUTPUT
on the top level is receiving (‘sinking’) data from a Driver Pin on an internal component instance in your SmartDesign

design.

The implied direction is essentially reversed at the top-level. Making connections from an OUTPUT of a component

instance to an OUTPUT of top-level is legal.

This same concept applies for bus interfaces; with normal instance to instance connections, a MASTER drives a

SLAVE interface. However, they go through a similar reversal on the top-level.
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About Bus Interfaces

A bus interface is a standard mechanism for specifying the interconnect rules between components or instances in a
design. A bus definition consists of the roles, signals, and rules that define that bus type. A bus interface is the

instantiation of that bus definition onto a component or instance.

The available roles of a bus definition are master, slave, and system.

A master is the bus interface that initiates a transaction (such as read or write) on a bus.

A slave is the bus interface that terminates/consumes a transaction initiated by a master interface.

A system is the bus interface that does not have a simple input/output relationship on both master/slave. This could
include signals that only drive the master interface, or only drive the slave interface, or drive both the master and slave
interfaces. A bus definition can have zero or more system roles. Each system role is further defined by a group name.

For example, you may have a system role for your arbitration logic, and another for your clock and reset signals.

Mirror roles are for bus interfaces that are on a bus core, such as CoreAHB or CoreAPB. They are equivalent in signal

definition to their respective non-mirror version except that the signal directions are reversed.

The diagram below is a conceptual view of a bus definition.
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Figure 33 - Bus Definition

See Also:

Using bus interfaces in SmartDesign
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Using Bus Interfaces in SmartDesign

Adding bus interfaces to your design enables SmartDesign to do the following:

° Auto connect compatible interfaces
e  Enforce DRC rules between instances in your design
° Search for compatible components in the project

The Catalog in the Project Manager contains a list of Actel-specific and industry standard bus definitions, such as
AMBA.

You can add bus interfaces to your design by dragging the bus definitions from the Bus Definitions tab in the Catalog

onto your instances inside SmartDesign.
Some Actel SmartGen cores have bus interfaces that are instantiated during generation.

Certain bus definitions cannot be instantiated by a user. Typically these are the bus definitions that define a hardwired
connection and are specifically tied to a core/macro. They are still available in the catalog for you to view their
properties, but you will not be able to add them onto your own instances or components. These bus definitions are

grayed out in the Catalog.

A hardwired connection is a required silicon interconnect that must be present and specifically tied to a core/macro.
For example, when using the Real Time Counter in a Fusion design you must also connect it to a Crystal Oscillator

core.
Maximum masters allowed - Indicates how many masters are allowed on the bus.
Maximum slaves allowed - Indicates how many slaves are allowed on the bus.

Default value - indicates the value that the input signal will be tied to if unused. See Default tie-offs with bus

interfaces.
Required connection - Indicates if this bus interface must be connected for a legal design.

Hover your mouse over a bus definition in the Project Manager Bus Definition Catalog to view the

masters/slave/default/required connection information.
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Adding Bus Interfaces to SmartDesign Components
To add a bus interface to a component:
1. Select a bus definition from the Bus Definitions tab in the catalog and drag it onto your top-level. The Add Bus
Interface dialog box opens (see figure below). A default name is assigned to your bus interface; you can specify

your own if you wish.

Add Bus Interface | x| |

Bus InketFace Mame: Instance Mare: MGMUXBLE_O
TnitiCFoSaye bif Bus Definition: InitCFgSave
Role: slave
Vendor: Actel
Mersion: 1.0
Confiquration Parameters
Parameter Yalue Consistent
Murnber OF Clients . es
Clietit M are kg Yes
Signal Map Definition
Bus Definition Component Instance
Signal Dir|Width| Req Signal Width
INITADDR [T any ez
[MITDATA, [ anw Yes
IMITDOME [T> 1 MNa
INITDATVALLD [T 1 Yes
CLIEMTDIM=0 <®]  any Yes

Help | (04 I Cancel

Figure 34 - Add Bus Interface Dialog Box
2. Click Map by Name to map the signals automatically. Map By Name attempts to map any similar signal names

between the bus definition and pin names on the instance.

3. (Optional) Click the Add Port checkbox to add ports to the top-level. If you choose to add ports, the Signal row

becomes a text editable field.
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Adding Bus Interfaces to SmartDesign Instances

To add a bus interface to your instance:
1. Select a bus definition from the Bus Definition tab in the Catalog and drag it onto your instance. The Add Bus
Interface dialog box opens (see figure below). A default name is assigned to your bus interface; you can specify

your own if you wish.

Add Bus Interface | x| |

Bus Inkerface Mame: Instance Name: FME_O
Act_bif Bus Definition: ACM
Role: masker

Wendor: Ackel

Map By Marne | Mersion: 1.0

Signal Map Definition
Bus Definition Component Instance
Signal Dir|Width| Req Signal Width
ACMADDR  <@] 8 es
ACMWDATA <] 8 Tes
ACMRDATA [T» & ‘ez
ACMWEN @1 Es

Help | (] 4 & ! Zancel

Figure 35 - Add Bus Interface Dialog Box

2. If necessary, enter the configuration parameters.

3. Click Map by Name to map the signals automatically. Map By Name attempts to map any similar signal names

between the bus definition and pin names on the instance.

Removing Bus Interfaces from Instances

Only bus interfaces that you explicitly added to an instance can be removed or deleted. Bus interfaces that were

instantiated as part of core generation cannot be deleted.

To delete user added bus interfaces, on the Canvas,, select the bus interface pin object, right-click, and choose Delete

Bus Interface; or, in the Grid, select the Port Name field, right-click, and choose Delete Bus Interface.
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Viewing Bus Interface Properties

To view the properties of a bus interface:

In the Canvas, select the bus interface pin object, right-click, and choose Properties. This opens the View Bus Interface

dialog box (see figure below).

¥iew Bus Interface - <InitClient_InitCfgSave_hif =

Bus Intetfare Mame: Instance Mame: FME_O
InitClient InitCFgSave bif Bus Definition: InitCFoSave
Raole: master
Yendor: Actel
Version: 1.0
Configuration Parameters
Parameter Yalue Consistent
Murnber OF Clients: 1 e
Client Mame |ritChent e

Signal Map Definition
Bus Definition Component Instance
Signal Dir|Width| Req Signal Width
IMITADDR <0] any ez CINIT_aADDR 9
IMITDATA, <0 anw ez CINIT_DATA 3
IMITDOME <ol 1 Mo CIMIT_DOKE 1
IMITDATWALLD €8] 1 ez nitClient_DAT WAL 1
CLIEMTAWAILD [T 1 Mo InitClhient_Atall 1
CLIENTDIM=0 [& any Yes i nitClient_DIM 9

Help | [% Close |

Figure 36 - View Bus Interface Properties Dialog Box

Bus Interface Details

Bus Interface Name: Name of bus interface.

Instance Name: Specifies the name of the instance.
Bus Definition: Specifies the name of the bus interface.
Role: Specifies the bus role (master or slave).

Vendor: Specifies the vendor for the bus interface.

Version: Specifies the version for the bus interface.
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Configuration Parameters

Certain bus definitions contain user configurable parameters.
Parameter: Specifies the parameter name.
Value: Specifies the value you define for the parameter.

Consistent: Specifies whether a compatible bus interface must have the same value for this bus parameter. If the bus
interface has a different value for any parameters that are marked with consistent set to yes, this bus interface will not

be connectable.

Signal Map Definition
The signal map of the bus interface specifies the pins on the instance that correspond to the bus definition signals. The
bus definition signals are shown on the left, under the Bus Interface Definition. This information includes the name,

direction, width, and required properties of the signal.

The pins for your instance are shown in the columns under the Component Instance. The signal element is a drop-
down list of the pins that can be mapped for that definition signal. Only pins that have the same direction and width

requirements will be shown.

If the Req field of the signal definition is Yes, you must map it to a pin on your instance for this bus interface to be

considered legal. If it is No, you can leave it unmapped.

If the Width field is 4ny there is no restriction on the width for this definition signal. That means a pin of any width
on your instance can be mapped to this signal. During bus interface connection, if the instance pins are of differing
widths, the bit connections will start from right to left. For example, if a 16-bit bus is connected to an 8-bit bus, the 8-
bit bus will be connected to bits 7 down to 0 of the 16-bit bus. The higher bits will be unmapped and tied off at

generation time.
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Modifying Bus Interface Details

Only bus interfaces that you explicitly added to an instance can be modified. Bus interfaces that were instantiated as

part of SmartGen core generation cannot be modified.

To modify the properties of a bus interface:
1. In the Canvas, select the bus interface pin object, right-click, and choose Modify Bus Interface (see figure
below).

Modify Bus Interface - <RCOscClk_bif=

Instance Mame: S0_ClockEBlock.
Bus Definition: RCOscClk

Role: masker
Yendor: Ackel

Map By Mame | Yersion: 1.0

Signal Map Definition
Bus Definition Component Instance
Signal Dir|'Wwidth| Req|Add Port Signal ¥Width
‘RCCLEOUT <] 1 tes [T CLEQUT 1

Help | Ik I Zancel

Figure 37 - Modify Bus Interface Dialog Box

2. Modify the bus interface details, configuration parameters, or signal map definition and click OK.

Map By Name attempts to map any similar signal names between the bus definition and pin names on the instance.

Finding Compatible Bus Interfaces

The SmartGuide feature helps you complete your design; when you have a specific bus interface on an instance, you

can find a compatible instance, component, or core to connect.

To find a compatible bus interface:

1. In the Canvas, select the bus interface pin object, right-click, and 